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1 Introduction
The Graphics Plugins for Adobe Premiere Pro, Avid and Edius are available in this version. This 
guide will therefore only concentrate on workflows related to these plugins. For information about 
other supported Graphics Plugins, please go to the relevant version of the Graphics Plugin 
Administrator Guide.

1.1 Typical Workflow 
A typical workflow starting with scene and template design, and ending with video rendering and 
playout consists of the following steps:

A graphics designer creates a scene in Viz Artist.
The scene is either added as a template to a Viz Trio show or created as a template for use 
with Viz Pilot in Template Wizard.
An editor or a journalist edits a video using an NLE system.

Using Vizrt’s Graphics Plugin, the user can access and add graphics to the video.
Graphics properties can be edited using the graphics templates in either the Graphics 
Plugin Editor, Viz Trio, Viz Pilot or Viz Pilot Edge.

The video clip is rendered and saved to a shared file server or a Media Asset Management 
(MAM) system, such as Viz One.
Once the file is saved or posted to the MAM system, it can also be added to a playlist for 
playout on Viz Engine.

The basic Graphics Plugin workflow

Import video -> Import graphic -> Move graphic to video

While third party NLE workstations have different ways of importing and inserting graphics into a 
video, the Graphics Plugin itself has the same interface across all third-party programs.

For details on how to use the Graphics Plugin in Adobe Premiere Pro, Avid Media Composer and 
Edius, please see the sections below.

http://docs.vizrt.com/viz-nle.html
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2 Using The Graphics Plugin With Adobe Premiere Pro
This section explains the required steps on how to add Vizrt graphics to the timeline in Adobe 
Premiere Pro, and how to use stop points.

Adding the Graphics Plugin
Stop Points

2.1 Adding The Graphics Plugin
Create a new project or open an existing project in Adobe Premiere Pro.
Add a Transparent Video clip to the project:

In the Project panel, make sure that the Project tab is selected, and click the New 
Item button in the lower right corner.
In the menu that appears, click Transparent Video...

In the New Transparent Video dialog box that opens, select your Video Settings and 
click OK.
Drag the new transparent video clip to the Timeline.

Add the Graphics Plugin to the project:
In the Project panel, click the Effects tab. (If the tab is not visible, select it from 
the Window drop-down menu bar).
Navigate to Video Effects > Vizrt > Graphics Plugin.
Drag the plugin onto the transparent video clip in the Timeline.
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Select the transparent video clip that holds the plugin.
Click the Effect Controls tab. (If the tab is not visible, select it from the Window drop-down 
menu bar).
Expand the Graphics Plugin option in the Video Effects list.
Click the Edit button to access the specified (done in the Configuration Tool) Graphics Plugin 
User Interface (Viz Trio, Viz Pilot Edge, Viz Pilot or Graphics Plugin Editor (Mac)) and to use 
Vizrt graphics.
Click the Setup... button (see image below) to access the Configuration Tool where you can, 
among many things, select your preferred Graphics Plugin User Interface. Go to 
the Configuration Tool section for more details.

Back in Adobe Premiere Pro, a graphics element has now been added to the transparent 
video clip.

Note:

The NLE application will freeze when the Configuration Tool or the User Interface is 
open.


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10. Create another Transparent Video with graphics plugin and drag it to the timeline to have 
multiple graphics.

2.2 Stop Points
Stop points are added to a graphics scene to control the playout of the animation.  

Adding a graphic using the Graphics Plugin there is a stop point editor that allows you to adjust 
the length of the stop points.

The stop point editor is located in the Effect Controls tab > Graphics Plugin > Control:

Click and drag the small square next to the stop point you want to adjust:



Graphics Plugin User Guide -  2.2

Copyright © 2023  Vizrt                                                          Page  9

•
•

1.
2.
3.

4.

5.
6.

7.

3 Using The Graphics Plugin With Avid Media 
Composer

This section explains the required steps on how to add Vizrt graphics to the timeline in Avid Media 
Composer, and how to use stop points.

Adding the Graphics Plugin
Stop Points

3.1 Adding The Graphics Plugin
In Avid Media Composer, create a new project.
Import a video through the Source Browser window.
Click on the film icon on the item that you imported, and drag it into the Timeline window.

In the Project window, click on the Effect Palette tab (represented by a square purple icon), 
select Vizrt > Graphics Plugin, and drag it into a separate video track in the Timeline.

Open the Effect Editor by going to Tools > Effect Editor.
In the Effect Editor window, under the Graphics Plugin, click on Editor to start importing 
graphics into Avid Media Composer. Viz Trio, Viz Pilot Edge, Viz Pilot or the Graphics Plugin 
Editor (Mac) will start depending on specified Graphics Plugin User Interface in 
the Configuration Tool.
Click on Config to access the Configuration Tool. 
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Check that you are in Effect mode in order to see graphics animations in the Preview 
windows.

Play the video clip or scrub the timeline to see the new effect.

3.2 Stop Points
Stop points are added to a graphics scene to control the playout of the animation.  

Adding a graphic using the Graphics Plugin there is a stop point editor that allows you to adjust 
the length of the stop points.

To access the stop point editor open the Effect Editor: 

Go to Tools from the top menu and select Effect Editor in the drop-down list. 

Under the Graphics Plugin, select the Toggle show/hide option.

Note:

The NLE application will freeze when the Configuration Tool or the User Interface is 
open.


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Enabling this option a stop point editor will appear at the bottom of the preview window:

Click the small square next to the stop point and drag to adjust it.
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4 Using The Graphics Plugin With EDIUS
This section explains the required steps on how to add Vizrt graphics to the timeline in EDIUS.

Accessing the Configuration Tool
Adding the Graphics Plugin

4.1 Accessing The Configuration Tool
To open the Graphics Plugin Configuration Tool in EDIUS, go to Tools > Vizrt Graphics Plugin:

The Configuration Tool opens in a separate window where you can among other things select your 
preferred Graphics Plugin User Interface. Go to the Configuration Tool for more details.  

4.2 Adding The Graphics Plugin
Before you can use Vizrt graphics, you have to add the Graphics Plugin to your project:

Create a new project or open an existing project in EDIUS.
Right-click on a video track on the timeline and select New Clip > Vizrt Graphics Plugin:
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3. A graphics element appears on the timeline at the same time as the Graphics Plugin Editor 
opens in another window.
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4. After closing the Graphics Plugin Editor, you can double-click the graphics element on the 
timeline to open it again to change or edit the graphics. 

Note:

For information about the graphics, right-click it on the timeline and select Properties....


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5 Configuration Tool
The Configuration Tool is identical independent of the application it is opened from. This section 
describes the Configuration Tool user interface and its options.

Reset All: Resets all settings to default (factory settings).
Performance: Opens the Performance Tester for Tuning the System.
OK: Saves the current configuration.
Cancel: Cancels all changes and closes the Configuration Tool.
Help: Opens the Graphics Plugin user guide.

Opening the Configuration Tool the General tab will be selected by default with the following 
settings:

Select render:
Specific VizEngine, or Connection Broker: Specify whether you are using a Viz Engine 
or Connection Broker as render. 

The Help button is not available in the configuration tool for Mac users. To access 
the documentation go to help in the menu bar.



http://docs.vizrt.com/graphics-plugin-guide/2.2/Tuning_the_System.html
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Media Sequencer: Specify the Media Sequencer.

The following sections describe the user-configurable settings under the Advanced tab and are 
divided based on the selected Settings view:

Important
Graphics Plugin
Viz Engine
Editor Settings
Startup Variables
Shared System Settings

5.1 Important
The Important Settings view displays the most important settings needed in order to run the 
Graphics Plugin.

Viz Engine Host: Sets the hostname or IP address of the Viz Engine renderer.
Viz Engine Use Connection Broker: Enables use of the Connection Broker, see Connection 
Broker.
Viz Engine Connection Broker host: Sets the host of the computer running the Connection 
Broker, see Connection Broker.
Media Sequencer Host: Sets the host of the computer running the Media Sequencer service.

http://docs.vizrt.com/graphics-plugin-guide/2.2/Connection_Broker.html
http://docs.vizrt.com/graphics-plugin-guide/2.2/Connection_Broker.html
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Graphics plugin User Interface: See User Interface.
Viz Engine Network compression: See Network compression.
Viz Trio NLE Host: Defines the hostname of the machine running the Viz Trio NLE. Typically, 
this hostname is localhost.
Viz Pilot NLE Host: Defines the hostname of the machine running the Viz Pilot NLE. Typically, 
this hostname is localhost.

5.2 Graphics Plugin

User Interface: Sets the interface to use for selecting graphics templates. 
Templates using the same scene but opened from Viz Trio, Viz Pilot or Viz Pilot Edge are 
different entities. Once an editor is set and used to add a graphic effect to the timeline the 

Settings view contains all settings that are separate and only apply the Graphics Plugin. 
These settings are not application specific settings such as those that apply Viz Engine and 
Graphics Plugin Editor.


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effect is also bound to that editor. To create an effect with a template from another editor 
the old effect must first be deleted, a new editor configured, and then a new effect created.
Log level: Set the log level in order to provide an error report to Vizrt. Only use it when it is 
specifically needed to make a report as it will slow the effect of the plugin. See the Log Files 
section in the Graphics Plugin Admin Guide for more information on log file locations.
If set to None, the plugin will only log errors, which is the default behavior.
If set to Report, the plugin will generate dated log files. It will in almost all cases include 
enough information in the log files to let Vizrt figure out the cause of problems. 
If set to Extreme, the plugin will generate a very large amount of logging information.
Log directory: Use this setting to override the default logging directory. See the Log Files 
section in the Graphics Plugin Admin Guide.
for more information on logging.
Should log fields/frames: Enables the plugin to dump all frames and fields it renders to the 
file system allowing the user and Vizrt support to identify issues related to the graphics. 
Files are dumped in a sub-directory of the Log directory.
Color correction: Enables broadcast-safe colors. Set cap-601 to cap high and low values 
directly to get 16-235. Set linear-cap-601 to perform a linear recalculation of the data to 
16-235. The default value is None.
Premultiply alpha: Configures whether the plugin will pre-multiply alpha or not when 
rendering. In some cases, the Viz Engine has already multiplied the color channels with the 
alpha channel.
Anti-aliasing: Determines whether requests for small frame sizes should be anti-aliased on 
the Viz Engine.
Untrusted SSL: Determines whether HTTPS servers with self-signed certificates should be 
trusted. 

5.3 Viz Engine
The Viz Engine Settings view is shown below:

http://docs.vizrt.com/viz-nle.html
http://docs.vizrt.com/viz-nle.html
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Host: Sets the hostname or IP address of the Viz Engine renderer.
Use Connection Broker: Enables the Graphics Plugin to connect to the Connection Broker for 
graphics rendering.
Connection Broker host: Sets the hostname or IP address of the Connection Broker (see 
Connection Broker).
Network compression: Sets the compression level. It is recommended to use no compression 
on gigabit networks, and compressed formats on slower networks (e.g. 100mbit). The 
default value is RLE.
No Compression for gigabit networks will send all frames across the network uncompressed.
PNG (Portable Network Graphics) is a lossless compression format.
RLE (Run-length Encoding) is a lossless compression format. RLE is only supported by Viz 
Engine 3.2.2. and later versions (see the Software Requirements section).
Prefetching: Prefetching, also known as caching, greatly increases the rendering speed when 
using a start to stop rendering, like Pinnacle's yellow slices, or Avid's pre-render effect 
mode.
Failsafe mode is off.
Default value is on.
Prefetch size: Use this setting to indicate how many frames or fields the plugin should pre-
fetch. A higher number improves start to stop rendering (pre-render) performance but 
reduces the scrub performance.
Note that this option is only available if pre-fetching is enabled. Prefetch values above 50 are 

http://docs.vizrt.com/graphics-plugin-guide/2.2/Connection_Broker.html
http://docs.vizrt.com/graphics-plugin-guide/2.2/Software_Requirements.html
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ignored.
Default value is 20. 
Network timeout: Sets the time for how long Viz Engine connections should wait for replies.
Unless network measurements for the Viz Engine have been performed, this setting should 
not be changed. Default value is 45 sec.
Information timeout: Sets the time for how long Viz Engine should wait for reply for initial 
information. 
Unless network measurements for the Viz Engine have been performed, this setting should 
not be changed. 
Network cleanup: Sets the time for how long the plugin should wait after last use before 
considering tidying up loose connections to the Viz Engine.
Unless the actual use of the plugin has been measured, this should not be changed. Default 
value is 8 mins.

5.4 Editor Settings
Toggle settings view to display settings for either the Graphics Plugin Editor, Viz Trio, Viz Pilot or 
Viz Pilot Edge. Common settings will be presented first, followed by editor-specific settings:

Host/URL: Sets the hostname or IP address (URL for Viz Pilot Edge app) of the machine 
running the Graphics Plugin Editor, Viz Trio or Viz Pilot.
Network timeout: Sets the time for how long connections to Graphics Plugin Editor should 
wait for replies.
Unless network data for the Graphics Plugin Editor has been measured this should not be 
changed.
Default value is 90s. 
Grace period: Sets the time for how long the Graphics Plugin should give the editor to start 
everything without interruptions.
Default time is 2s.

Host port number restrictions when previewing templates on Editor Viz engine port 
50007 or 50107 must be used in order to preview templates on Graphics Plugin 
Editor, Viz Trio, Viz Pilot or Viz Pilot Edge. These ports connect to preview ports 
50008 and 50108, respectively. See Network Requirements for port numbering 
information.


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5.4.1 Viz Trio NLE

Executable: Name of the editor's executable file. Can be changed in case another filename is 
in use than the usual.
Default value is trionle.exe.
Options: The exact command line options string that should be passed to the editor’s 
process at startup.
For more information on command line options, see the Startup Variables section.
Shared folder: Shared path used for temporary files during import of Viz Trio shows. Both 
the Graphics Plugin and the external Viz Engine should have full access to this folder.
Shared folder for Viz Engine: Shared path as seen from the Viz Engine machine, must refer 
to the previous setting. Only needed if the external Viz Engine uses a different path (e.g 
mapped network drive) for the same folder.
Drive remappings: Semicolon-separated list of drive remappings used during import of Viz 
Trio shows. These will cause associated files of the specified file types to be unpacked to a 
different drive letter than stored in the *.trioshow file. Each mapping is on the form 
wildcard=driveletter.

Viz Pilot NLE
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Executable: Name of the editor's executable file. Can be changed in case another filename is 
in use than the usual.
Default value is VcpAxNle.exe.
Options: The exact command line option(s) string that should be passed to the editor’s 
process at startup. For more information on command line options, see the Startup Variables
section.
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5.4.2 Viz Pilot Edge

Viz One Username: The username to log in to Viz One. 
Viz One Password: The password to log in to Viz One.
Graphic Hub Username: The username to log in to Graphic Hub.
Graphic Hub Password: The password to log in to Graphic Hub.

When using Pilot Edge in a regular browser (Chrome/Firefox/IE): If Pilot Data Server is configured 
to use a Viz One server, or the user has manually specified a Viz One server via URL parameters (by 
appending "?vizone=hostname" to the end of the URL), but no default password has been 
configured in Pilot Data Server settings, the popup below will appear. If the username and 
password are not entered, the server's media will be unavailable for the duration of the session 
and will not be visible while browsing Pilot Edge.
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5.4.3 Graphics Plugin Editor
VOS image search: URI template for image search from Object Store, a component of Viz 
Pilot. This requires the Viz Pilot Data Server. Being a URI template means there should be a 
placeholder in the text you enter, indicated by curly-brackets, which gets replaced by 

Pop-ups are not shown when Pilot Edge is used via the NLE Editor. Any authentication 
request will therefore always fail silently. This can be remedied by filling in the Username
and Password fields. If the server requests additional authentication for either Viz One or 
Graphic Hub, the above fields will be used. However, if the server does not request Viz 
One / Graphic Hub credentials, either because valid credentials already exist server side, or 
because no Viz One / Graphic Hub is configured, these fields will be silently ignored.


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specific search terms, as in this example: http://vcpserver.example:8177/vos/search?

q=\{query }.

5.4.4 Adobe/Avid/Edius* settings
* depending on your NLE application.

Still image playback: Only render still images to increase performance when low-quality 
frames are requested. This will affect scrubbing and playback. A high-quality frame will 
eventually be rendered upon scrubbing, which will show the correct representation of the 
graphics after rendering. 

5.4.5 To perform an Object Store image search
Create a sequence.
Add a clip to the sequence.
Drag the Graphics Plugin effect to the sequence.
Double-click the effect, and select the Controls tab at the top of the screen.
From the Controls panel, click Graphics Plugin Config.
In the Graphics Plugin Configuration Tool window that opens, click the Advanced tab.
From the Settings view list, click All settings.
Locate the VOS image search, and set the path to your Object Store.
Click OK.
Back in the Controls panel, click Graphics Plugin Editor.

http://vcpserver.example:8177/vos/search?q={query
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In the Graphics Plugin Editor window that opens, select a show and then a template 
containing an image field.
From the Information fields list, select the field that contains the image.
From the window that opens, click the Search tab.
Type a search string that matches your preferences in the search field.
From the list of images on your app server, select the one you prefer.
The image is being updated both as a thumbnail in the Information fields list and in the 
preview window.
Click OK to return to the sequence view.

5.5 Startup Variables
Options are used as variables for the actual value set for the plugin. The options can be used as 
part of an editor’s startup options.

The following options are available and configurable:

MSE_HOST: References the active Media Sequencer host.
Example: -mse MSE_HOST

LOG_PATH: Refers to the currently used Plugin log directory.
Example: -logfile-path "LOG_PATH"

5.6 Shared System Settings
This section covers the shared settings feature that is available to Windows users in the system 
registry.

The system stores the settings in a per-user directory, for example under C:\Documents and 

The startup options are only valid for NLE editors on Windows.
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Settings\<username> . Placing the same file in a shared directory allows multiple users to use a 

standardized setup overriding per-user settings.

By adding a Windows registry entry with a path to the master configuration file, the settings in that 
file will take precedence over the default values for the various settings, but the individual settings 
that the user changes in the Graphics Plugin configuration tool will take precedence over the 
master configuration file.

HKEY_LOCAL_MACHINE/SOFTWARE/[vizrt]/NLE/AVX2/SettingsDir

Given a particular setting, the following rules apply:

If a setting has been set using the Graphics Plugin configuration tool, that value is used, 
otherwise;
if it has a value in the master configuration file, that value is used, otherwise;
the default value for the setting is used.

To add a shared system setting

Start Graphics Plugin configuration tool.
Configure the Graphics Plugin using the configuration tool.
Save and exit the configuration tool.
Find the file vizplugin.xml in the current user's Application Data folder.
Copy the file to the designated shared location.
Set up the SettingsDir registry entry to point to the shared directory location where the 
copied file was placed.

5.7 Performance Tester
The Performance Tester is accessed by clicking the Performance button at the lower left in the 
Graphics Plugin Configuration Tool. The purpose of the tool is to test various configurations. It will 
test the Graphics Plugin directly and how it performs on the network, as well as the rendering and 
how quickly the Graphics Plugin returns graphics to the NLE system, which is the raw speed of the 
plugin.

The tester does not test the time it takes to fill the NLE system's frame buffer or the time used 
between each request for frames to the NLE system. It is therefore recommended to test the NLE 
system once the Graphics Plugin is tested and found to be working satisfactorily.

Shared settings does not apply to Mac users.
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Results table: Shows a table of results displaying the protocol tested, prefetch size, time and 
frames per second achieved.
Viz Engine: Sets the Viz Engine host to be used for testing.
Image protocol: Sets the parameter for how to transfer the graphics over the network. Select 
one or multiple options and choose between RLE, PNG and No compression.
Prefetch size: Sets the pre-fetching that will be tested. Available options are 5, 10 or 20
frames or fields.

Scene name: Sets a particular scene that can be loaded and tested (e.g. 02_GFX/VizNLE/

1000 ).

Clip length: Sets the length of the clip that is to be rendered. 5 or 10 seconds are good 
starting points to check the rendering time.
Pause time: Sets the pause in milliseconds between renders, that is the time that an NLE 
system uses to process the previous data. This would be lower for SD than for HD. It is 
recommended to try other values between 0 and 100 ms+ to see how this affects the 
network use. For more information, see the Tuning the NLE System section on the Questions 
and Answers page.
Video mode: Sets the Viz Engine video mode to either:

1080i 50 FPS
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1080i 60 FPS
720p 50 FPS
720p 60 FPS
PAL
NTSC

Run tests: Tests the current settings configured for the plugin with the clip length and pause 
options set. This is useful when performing tests with concurrent users.
Test summary: Shows a report of problems and various statistics.

Once the settings that give the optimal results are found they can be set in the Viz configuration 
tool manually so that the settings can be tested with the actual NLE system.
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6 Graphics Plugin User Interfaces
This section describes user interfaces that can be used with the Graphics Plugin. The NLE version 
of Viz Trio is bundled with the Graphics Plugin installation. The Graphics Plugin Editor is the user 
interface for Mac machines since Viz Trio is not supported. Viz Pilot Edge can be used by providing 
the URL in the Configuration Tool. Viz Pilot can also be used as the user interface if it's installed on 
your computer.

Click the Edit button in Adobe Premiere Pro, or the Editor button in Avid to open the user interface 
selected in the Configuration Tool in a separate window. 

This section contains more information about how to use the various user interfaces:

Viz Trio
Viz Pilot Edge
Viz Pilot
Graphics Plugin Editor

6.1 Viz Trio
 If Viz Trio NLE has been selected in the Configuration Tool, the following Viz Trio window will 
open:

Select a graphics template by double-clicking it in the Page List. The graphic will open in the Side 
Editor where it can be edited and previewed in the window below:
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When your graphics is ready to be used in your NLE system, click the Save As NLE button to avoid 

overwriting the page: 

The graphics will be given a new Page ID.

Click Save and render in NLE  . Viz Trio will close and the graphics will 
appear in your NLE system.

For more information on how to use Viz Trio, please see the Viz Trio User Guide.

6.2 Viz Pilot Edge
If Viz Pilot Edge has been selected in the Configuration Tool,  the following Viz Pilot Edge window 
will open, where the user can browse for graphics.

Click Find Graphics.

http://docs.vizrt.internal/viz-trio.html
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Select a graphics element or a template at the bottom of the dialog that appears by double-clicking 
it.
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The graphics will open in a new window where you can edit the content of the graphics in the fill-in 
form to the left and preview the output at the right in the application. When your graphics is ready 
to be used, click Ok. Viz Pilot Edge will close and the graphics will appear in your NLE application.  

If you edit a template or data element and then attempt to open a different one, a dialog 
will appear which allows you to save the first template or element.
Creating a new data element cannot be done in Viz Pilot Edge through the NLE application, 
but must be done separately in Viz Pilot Edge in a browser.


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For more information on how to use Viz Pilot Edge, please see the Viz Pilot Edge User Guide.

6.3 Viz Pilot
If Viz Pilot NLE has been selected in the Configuration Tool, the following window will open where 
the user can browse for templates and data elements.

The left side of the window lists available templates in the database while the right side lists 
available data elements (saved templates). 

https://docs.vizrt.com/viz-pilot-edge.html
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Select a template or element by double-clicking it and edit the content of the graphics to the left 
and preview the output at the right in the application. 

In order to use a template subsequently, you must save it as a data element by clicking Save 
As, giving it a name and clicking Save as new. This closes the Viz Pilot NLE application and the 
graphics element will appear in your NLE application.

If you are using an already existing data element click Save to use the data element as is or to 
overwrite any changes. Click Save As to create a new data element. In both cases, the Viz NLE 
application will close and the graphics element will appear in your NLE application.
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For more information on how to use Viz Pilot, please see the Viz Pilot User Guide.

6.4 Graphics Plugin Editor
This section describes the Graphics Plugin Editor’s interface which is only available for Mac users. 
If you're using Viz Pilot Edge or Windows with Viz Pilot or Viz Trio, please see the relevant sections 
above.

This section covers the following topics:

Menu Options in Graphics Plugin Editor
Information Fields in Graphics Plugin Editor
Preview Settings in Graphics Plugin Editor

https://docs.vizrt.com/viz-pilot.html
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6.4.1 Menu Options in Graphics Plugin Editor
The following menu options are unique to the Graphics Plugin Editor. Other options are generic 
options provided by the operating system.

Page
Save Page (Cmd+S): Saves a page back to the Media Sequencer.
Next tabfield (Cmd + Arrow Down): Selects the next tabfield.
Previous tabfield (Cmd + Arrow Up): Selects the previous tabfield.

Show
Import Trio XML Archive: Imports an exported Viz Trio archive. The import recreates 
the exported show on the connected Media Sequencer.
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6.4.2 Information Fields in Graphics Plugin Editor
The Graphics Plugin Editor supports the most common control properties; however, it is only 
possible to input text, change numerical values, select images, geometries, fonts and materials.

There is no support for input of boolean values, editing of lists and tables or scrolls. However, the 
editor can use and render Viz Trio pages made using a regular Viz Trio even though they have 
these field types.

6.4.3 Preview Settings in Graphics Plugin Editor
The following may be set for the preview:

Safe area: Shows the defined safe area configured by the current Viz Engine.
Title area: Shows the defined title area configured by the current Viz Engine.
Key: Shows the graphics’ key signal.
Bounding boxes: Shows the bounding boxes for the graphical elements in the scene.

Note:

When performing an import you should always make sure that the scenes are available to 
the connected Viz Engine.


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7 Scene Design
When designing scenes in Viz Artist that are to be used together with Supported NLE Systems, it's 
important to follow specific design conventions, in order for the output to render correctly.

The following notes must be taken into consideration when designing for the Graphics Plugin 
workflow:

Key
Stop Points
Stretching Stop Points
Directors and Stop Points
Sound and Stop Points
Video and Stop Points
Effect Plugins
Transition Logic
Lift and Extract

7.1 Key
When designing a scene that is to be used in the Graphics Plugin workflow, a key signal must be 
added to the scene, in order for the graphics to blend correctly with the video.

The key signal can be created by adding the Key plugin to one or more containers in the scene, or 
by enabling Auto Key under the global scene settings.

7.2 Stop Points
If you are using stop points when designing a scene that is going to be used in the Graphics Plugin 
workflow, they must be added to the directors at the root level of the Stage.

In a scene that contains only one stop point, the in-animation takes place on the left side of the 
stop point in the Stage, while the out-animation is visualized on the right side. The stop point will 
automatically be converted to a pause point, and if needed, stretched, to make the entire 
animation (in, pause, and out) match the length of the graphics element in the NLE timeline.

7.3 Stretching Stop Points
The stop points in a scene will automatically be stretched, in order for the animation to match the 
length of the graphics element in the NLE timeline.

As an example, imagine having an in-animation of 3 seconds and an out-animation of 4 seconds. If 
the animation is stretched to 10 seconds in the NLE timeline, the in-animation will be shown for 3 
seconds, followed by the stop point between the in- and out-animation that will be stretched to 3 
seconds, and then the out-animation will be shown for 4 seconds, totaling to 10 seconds.

http://docs.vizrt.com/graphics-plugin-guide/2.2/Supported_NLE_Systems.html
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In another example, if the animation above is shortened to 5 seconds, it will show the in-animation 
for 3 seconds, skip the pause point, and then cut the out-animation down to 2 seconds.

Multiple stop points will be stretched evenly unless you have a modified one. If the animation 
contains two stop points and is stretched to 17 seconds, then the in-animation will be shown for 3 
seconds, the first stop point for 5 seconds, the second for another 5 seconds, and then finally the 
out-animation for 4 seconds. If a user modifies a  stop point, any resize operation will attempt to 
only readjust the rightmost stop point, if possible. 

7.4 Directors And Stop Points
Stop points that are used to pause and stretch animations, must be placed in directors at the root 
level of the Viz Artist Stage. Stop points that are placed in sub-directors (not at the root level), will 
be ignored by the NLE system.

Animations that are paused and stretched must also be placed in directors at the root level of the 
Viz Artist Stage. Any animations in sub-directors will not be stretched, hence looping background 
animations and similar should be placed here. These animations will be played out continuously, 
regardless of the stop points in the root containers.

7.5 Sound And Stop Points
There is no support for embedded sound effects in graphics being used in the Graphics Plugin 
workflow. Sound that is embedded together with graphics is based on the timeline used for the 
graphics, and there is no good and general way of stretching sound.

7.6 Video And Stop Points
Through the use of various Viz Artist plugins, such as MoViz, it is possible to play media files or 
streams as part of the output of a graphics scene. Note that the video will be stretched according 
to the length of the graphics clip in the NLE timeline.

7.7 Effect Plugins
Effect plugins, such as RFxSmoke, works in such a way that particles are emitted from a certain 
point, and then moved in a random order in some direction until they eventually fade away. The 
output of this random particle movement may be distorted when played out as part of the 
Graphics Plugin workflow. Hence, it is recommended to use such effects with caution when 
designing for NLE.

7.8 Transition Logic
The Graphics Plugin workflow makes it is possible to work with Transition Logic scenes, with 
certain limitations.
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Following the normal workflow of the supported NLE systems, the graphics templates can be 
modified and sent to air. A template that contains multiple elements, such as a banner, logo, and a 
lower third, can be animated to the various in and out states so that it matches the timing of the 
graphics event in the timeline.

The following limitations apply to Transition Logic scene design:

There is no support for graphics that are dependent on states of other graphics elements. 
For example, a normal Transition Logic scene can be designed to have a logo taken on air in 
the lower part of the screen, and then when a lower third is taken on air, the logo should 
shift to the upper part of the screen. To achieve this type of behavior; create a combination 
template, using Viz Trio or Viz Pilot’s Template Wizard, to control the required layers, such 
as bug, clock, lower third, OTS, and so on.
There is no support for multiple graphics stacked together, so-called in-to-in or back-to-
back animations. For example, when showing two instances of a lower third straight after 
another on the timeline, it is not possible to keep the backplate from object number one, 
and simply update the editable variables, in this case, the name of the interview objects. 
Instead, the first element must be animated out, and then the second one in.

See Also

Viz Artist User Guide sections on Transition Logic
Viz Trio User Guide section on Combination Templates

7.9 Lift And Extract
When using Viz Pilot as your Editor, Lift and Extract allow you to remove a portion of a clip from 
the timeline. This is usually set by the mark-in and mark-out points.

Lift will remove a portion of a clip while leaving the interval duration between the mark-in 
and mark-out points.
Extract will remove a portion of a clip, but does not leave the interval (cutting the portion of 
the clip out completely).

Although Lift and Extract modify the clip, no frames in the graphic are skipped. The portions of 
the clip before mark-in and after mark-out are separate entirely, and the graphic will also be split.

https://docs.vizrt.com/viz-artist.html
https://docs.vizrt.com/viz-trio.html
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